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Introduction 1
Overview

About This
Product

The TaqMan® Human Endogenous Control Plate is a research tool 
designed to simplify the selection of endogenous controls for gene 
expression studies. The plate evaluates the expression of eleven select 
housekeeping genes in total RNA samples using a two-step, reverse 
transcription–polymerase chain reaction (RT-PCR). The plate also 
features a unique internal positive control (IPC) designed to detect the 
presence of PCR inhibitors in test samples. 

In This Chapter The following topics are discussed in this chapter:

Topic See Page

Control Plate Assay System 1-2

Preventing Contamination 1-9

Materials and Equipment 1-10

Safety 1-13

1
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Control Plate Assay System

Purpose of the Kit Applied Biosystems® developed the TaqMan Human Endogenous 
Control Plate to simplify endogenous control selection by eliminating 
several major developmental obstacles. The following table explains 
difficulties researchers face when investigating potential controls and 
how the plate alleviates these problems.

Instruments This protocol describes how to evaluate candidate control gene 
expression in total RNA samples using the plate and the following 
sequence detection systems:

♦ ABI PRISM® 7700 Sequence Detection System

♦ GeneAmp® 5700 Sequence Detection System

Obstacle Solution

Assay development and optimization 
is expensive and time-consuming.

The TaqMan Human Endogenous 
Control Plate features 11 
preoptimized, ready-to-use control 
gene assays.

Several studies indicate that 
expression of traditional 
housekeeping genes, such as 
GAPDH and beta-actin, varies among 
tissues and developmental stages 
(Bonini and Hofmann, 1991; 
Spanakis, 1993).

The TaqMan Human Endogenous 
Control Plate simultaneously 
evaluates eleven candidate 
controls that cover a broad range of 
biological functions and vary in 
expression levels. 

Recent studies indicate that 
pseudogenes and related genes 
make RT-PCR results unreliable 
unless the PCR primers are 
cDNA-specific (Raff et al., 1997; 
Multimer et al., 1998).

TaqMan endogenous control 
assays are cDNA-specific, and 
their performance was tested using 
cDNA prepared from human total 
RNA samples. 
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About TaqMan
Endogenous

Control Assays

With the exception of 18S rRNA, all assays present on the TaqMan 
Human Endogenous Control Plate are cDNA-specific. Each assay has 
been experimentally proven not to detect up to 10,000 copies of 
contaminating DNA.

The 18S rRNA assay is not cDNA-specific. However, because of the 
extremely high expression level of rRNA, amplification from 
contaminant DNA has a negligible effect on gene expression values 
obtained from the plate. In spite of these design characteristics, Applied 
Biosystems recommends using only purified total RNA samples.

About the Internal
Positive Control

Applied Biosystems designed the TaqMan Internal Positive Control 
(IPC) to help interpret negative results caused by PCR inhibitors. In the 
absence of inhibitors, IPC is co-amplified with the target DNA and gives 
a consistent signal. If inhibitors are present, the signal generated by the 
IPC assay diminishes or becomes nonexistent. The IPC sequence is 
artificial to prevent nonspecific amplification.

Product
Guidelines

Read the following information before proceeding:

♦ The endogenous control plate cannot be used to conduct multiplex 
experiments. It is designed only as a tool to aid in the selection of 
endogenous controls.

♦ The endogenous control plate should not be used to assay poly A+ 
RNA samples. The 18S rRNA assay cannot evaluate poly A+ RNA 
samples because most of the ribosomal RNA has been removed. 
Applied Biosystems designed the plate to evaluate only total RNA.

♦ Reverse transcription of total RNA to cDNA must be done using 
random hexamers.

♦ ABI PRISM 7700 Sequence Detection Systems must be calibrated 
for the VIC™ dye before running the TaqMan Human Endogenous 
Control Plate. See “Configuring the ABI Prism 7700 Software for 
the VIC Dye” on page 3-2 for more information.

♦ The endogenous control plate is optimal for use with the following:

– ABI PRISM 7700 Sequence Detection System and 
GeneAmp 5700 Sequence Detection System

– TaqMan® Universal PCR Master Mix (P/N 4304437)

– TaqMan® Reverse Transcription Reagents (P/N N808-0234)



1-4 Introduction

About the TaqMan
Human

Endogenous
Control Plate

The TaqMan Human Endogenous Control Plate is a MicroAmp® Optical 
96-Well Reaction Plate divided into 12 columns, one for every control 
assay. Each column consists of eight identical wells containing TaqMan 
primers and probes for the detection of one target gene. The figure 
below illustrates the assay configurations on the plate.

Note See Appendix B, “About These Assays,” for a list of the TaqMan assays 
and their functions.

Column Control Assay Abbreviation

1 Internal Positive Control IPC

2 18S rRNA 18S

3 Acidic ribosomal protein huPO

4 Beta-actin huβA

5 Cyclophilin huCYC

6 Glyceraldehyde-3-phosphate dehydrogenase huGAPDH

7 Phosphoglycerokinase huPGK

8 β2-Microglobulin huβ2m

9 β-Glucronidase huGUS

10 Hypoxanthine ribosyl transferase huHPRT

11 Transcription factor IID, TATA binding protein huTBP

12 Transferrin receptor huTfR

A

B

C

D

E

F

G

H

1 2 3 4 5 6 7 8 9 10 11 12
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Procedure
Flowchart

The following diagram is a simplified overview of this protocol:

RT thermal cycling

Prepare PCR reaction mix
and load the TaqMan Human

Endogenous Control Plate

PCR thermal cycling

Data analysis:
set baseline and
threshold values

Export analyzed data

Spreadsheet analysis

Graph the results and
select a control

Prepare total RNA samples
and RT reaction mix

A
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How TaqMan
Endogenous

Control Assays
Work

The TaqMan Human Endogenous Control Plate kit evaluates RNA 
expression in a two-step reverse transcription–polymerase chain 
reaction (RT-PCR). The figure below illustrates the assay steps.

In the RT step, cDNA is reverse transcribed from total RNA samples 
using random hexamers from the TaqMan Reverse Transcription 
Reagents. In the PCR step, products are synthesized from cDNA 
samples using the TaqMan Universal PCR Master Mix.
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Basics of the
5´ Nuclease Assay

The PCR reaction exploits the 5´ nuclease activity of AmpliTaq Gold® 
DNA Polymerase to cleave a TaqMan® probe during PCR. The TaqMan 
probe incorporates a VIC reporter dye at the 5´ end of the probe and a 
quencher dye at the 3´ end of the probe.

During the reaction, cleavage of the probe separates the VIC reporter 
dye and the quencher dye, which results in increased fluorescence of 
the reporter. Accumulation of PCR products is detected directly by 
monitoring the increase in fluorescence of the reporter dye as shown in 
the figure below.

When the probe is intact, the proximity of the reporter dye to the 
quencher dye results in suppression of the reporter fluorescence 
primarily by Förster-type energy transfer (Förster, 1948; 
Lakowicz, 1983). During PCR, if the target of interest is present, the 
probe specifically anneals between the forward and reverse primer 
sites.

The 5´→3´ nucleolytic activity of the AmpliTaq Gold DNA Polymerase 
cleaves the probe between the reporter and the quencher only if the 
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R
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probe hybridizes to the target. The probe fragments are then displaced 
from the target, and polymerization of the strand continues. The 3´ end 
of the probe is blocked to prevent extension of the probe during PCR. 
This process occurs in every cycle and does not interfere with the 
exponential accumulation of product. 

The increase in fluorescence signal is detected only if the target 
sequence is complementary to the probe and is amplified during PCR. 
Because of these requirements, any nonspecific amplification is not 
detected.

About AmpliTaq
Gold DNA

Polymerase

AmpliTaq Gold is a thermal stable DNA polymerase. The enzyme has a 
5´→3´ nuclease activity, but lacks a 3´→5´ exonuclease activity 
(Innis et al., 1988; Holland et al.,1991). When using AmpliTaq Gold 
enzyme, you can introduce Hot Start PCR and Time Release PCR into 
existing amplification systems with little or no modification of cycling 
parameters or reaction conditions. These techniques improve 
amplification of most templates by lowering background and increasing 
amplification of specific products. 

TaqMan Universal
PCR Master Mix

TaqMan Universal PCR Master Mix is 2X in concentration and contains 
sufficient reagent to perform 200 reactions (50 µL each). The mix is 
optimized for TaqMan reactions and contains AmpliTaq Gold DNA 
Polymerase, AmpErase UNG, dNTPs with dUTP, Passive Reference, 
and optimized buffer components.
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Preventing Contamination

Introduction Because of the high throughput and repetitive nature of the 5´ nuclease 
assay, special laboratory practices are necessary in order to avoid false 
positive amplifications (Kwok and Higuchi, 1989). This is because of the 
capability for single DNA molecule amplification provided by the PCR 
process (Saiki et al., 1985; Mullis and Faloona, 1987).

About
AmpErase UNG

AmpErase uracil-N-glycosylase (UNG) is a pure, nuclease-free, 26-kDa 
recombinant enzyme encoded by the Escherichia coli 
uracil-N-glycosylase gene. This gene was inserted into an E. coli host 
to direct expression of the native form of the enzyme (Kwok and 
Higuchi, 1989).

UNG acts on single- and double-stranded dU-containing DNA. It acts by 
hydrolyzing uracil-glycosidic bonds at dU-containing DNA sites. The 
enzyme causes the release of uracil, thereby creating an 
alkali-sensitive apyrimidic site in the DNA. The enzyme has no activity 
on RNA or dT-containing DNA (Longo et. al., 1990).

General PCR
Practices

Please follow these recommended procedures:

♦ Wear a clean lab coat (not previously worn while handling amplified 
PCR products or during sample preparation) and clean gloves 
when preparing samples for PCR amplification.

♦ Change gloves whenever you suspect that they are contaminated.

♦ Maintain separate areas, dedicated equipment, and supplies for: 

– Sample preparation

– PCR setup

– PCR amplification 

– Analysis of PCR products

♦ Never bring amplified PCR products into the PCR setup area.

♦ Open and close all sample tubes carefully. Try not to splash or 
spray PCR samples.

♦ Keep reactions and components capped as much as possible.

♦ Use positive-displacement pipettes or aerosol-resistant pipette tips.

♦ Regularly clean benches and equipment with 10% bleach solution.
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Materials and Equipment

Kit Components TaqMan Human Endogenous Control Plates are available in the 
following configurations:

Materials Storage
Guidelines

The table below lists the storage conditions for the TaqMan Human 
Endogenous Control Plate Kit and reagents used in this protocol.

IMPORTANT Do not remove the TaqMan Human Endogenous Control Plate 
from its packaging until ready to use. Excessive exposure to light damages the 
fluorescent probes. 

P/N Contents

4309920

4309921

Component P/N

TaqMan Human Endogenous Control Plates (2) —

TaqMan Universal PCR Master Mix 4304437

TaqMan Human Control Total RNA 4307281

TaqMan Human Endogenous Control Plate 
Protocol

4308134

Component P/N

TaqMan Human Endogenous Control Plates (2) —

TaqMan Universal PCR Master Mix 4304437

Kit Component/Reagent Storage Conditions

TaqMan Human Endogenous Control Plate 2 to 8 °C, dark

TaqMan Universal PCR Master Mix 2 to 8 °C, dark

TaqMan Human Control Total RNA –15 to –25 °C
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Materials and
Equipment Not

Included

Some equipment and materials are required in addition to the reagents 
supplied with the TaqMan Human Endogenous Control Plate. Many of 
the items listed are available from major laboratory suppliers (MLS). 
Equivalent sources are acceptable where noted.

Sequence Detection Systems Source

ABI PRISM 7700
Sequence Detection System

Contact your local Applied 
Biosystems sales office for the 
instrument best suited to meet 
your needs.

GeneAmp 5700 
Sequence Detection System

User-supplied materials: 

Materials Source

MicroAmp Optical 96-Well Reaction 
Plate/Optical Caps

Applied Biosystems 
(P/N 403012)

Note The MicroAmp Optical 96-Well Reaction Plate may be sealed with:

♦ MicroAmp Optical Caps

or

♦ ABI PRISM™ Optical Adhesive Cover
The Optical Adhesive Cover must be used with a compression pad and 
applicator, which are included in the starter pack.

ABI PRISM Optical Adhesive Cover Starter 
Pack

♦ 20 optical adhesive covers

♦ 1 applicator

♦ 1 compression pad

Applied Biosystems
(P/N 4313663)

Sequence Detection Systems 
Spectral Calibration Kita

Applied Biosystems 
(P/N 4305822)

TaqMan Reverse Transcription Reagents Applied Biosystems 
(P/N N808-0234)

Centrifuge with 96-well plate adapter MLS

Disposable gloves MLS

Microcentrifuge MLS

Microcentrifuge tubes, sterile, 1.5 mL MLS

MicroAmp Reaction Tubes with Caps Applied Biosystems 
(P/N N802-0540)

Microsoft® Excel (or equivalent software) Software vendors
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Pipette tips, aerosol resistant MLS

Pipettors:

♦ Positive-displacement

♦ Air-displacement

MLS

Polypropylene tubes MLS

Water, RNase-free, distilled, deionized MLS

a. Only for 7700 instruments not calibrated with the VIC dye. See “Configuring the 
ABI Prism 7700 Software for the VIC Dye” on page 3-2 for more information.

User-supplied materials: (continued)

Materials Source
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Safety

Documentation
User Attention

Words

Five user attention words appear in the text of all Applied Biosystems 
user documentation. Each word implies a particular level of observation 
or action as described below.

Note Calls attention to useful information.

IMPORTANT Indicates information that is necessary for proper instrument 
operation.

Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury. It may also be used to alert against 
unsafe practices.

Indicates a potentially hazardous situation which, if not 
avoided, could result in death or serious injury.

Indicates an imminently hazardous situation which, if not 
avoided, will result in death or serious injury. This signal word is to be limited to 
the most extreme situations.

Chemical Hazard
Warning

CHEMICAL HAZARD. Some of the chemicals used with 
Applied Biosystems instruments and protocols are potentially hazardous and 
can cause injury, illness, or death.

♦ Read and understand the material safety data sheets (MSDSs) 
provided by the chemical manufacturer before you store, handle, or 
work with any chemicals or hazardous materials.

♦ Minimize contact with and inhalation of chemicals. Wear 
appropriate personal protective equipment when handling 
chemicals (e.g., safety glasses, gloves, or protective clothing). For 
additional safety guidelines, consult the MSDS.

♦ Do not leave chemical containers open. Use only with adequate 
ventilation.

♦ Check regularly for chemical leaks or spills. If a leak or spill occurs, 
follow the manufacturer’s cleanup procedures as recommended on 
the MSDS.

♦ Comply with all local, state/provincial, or national laws and 
regulations related to chemical storage, handling, and disposal.

CAUTION!

WARNING!

DANGER!

WARNING!
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Ordering MSDSs You can order free additional copies of MSDSs for chemicals 
manufactured or distributed by Applied Biosystems using the contact 
information below.

For chemicals not manufactured or distributed by Applied Biosystems, 
call the chemical manufacturer.

To order 
MSDSs... Then...

Over the Internet a. Go to our Web site at 
www.appliedbiosystems.com/techsupp

b. Click MSDSs

c. You can open and download a PDF (using Adobe® 
Acrobat® Reader™) of the document by selecting it, 
or you can choose to have the document sent to you 
by fax or email.

By automated 
telephone service 
from any country

Use “To Obtain Documents on Demand” on page D-7. 

By telephone in 
the United States

Dial 1-800-327-3002, then press 1.

By telephone from 
Canada

By telephone from 
any other country

See the specific region in “To Contact Technical Support 
by Telephone or Fax” on page D-3.

If you have... Then...

The MSDS document 
number or the Document 
on Demand index 
number

Enter one of these 
numbers in the 
appropriate field on this 
page.

The product part number Select Click Here, then 
enter the part number or 
keyword(s) in the field 
on this page.

Keyword(s)

To order in... Then dial 1-800-668-6913 and...

English Press 1, then 2, then 1 again

French Press 2, then 2, then 1
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Site Preparation
and Safety Guide

A site preparation and safety guide is a separate document sent to all 
customers who have purchased an Applied Biosystems instrument. 
Refer to the guide written for your instrument for information on site 
preparation, instrument safety, chemical safety, and waste profiles.
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Reverse Transcription2
Overview

About This
Chapter

This chapter covers reverse transcription (RT), a process in which 
cDNA is synthesized from total RNA samples. Reverse transcription is 
the first step in the two-step RT-PCR gene expression quantification 
experiment, as described in “How TaqMan Endogenous Control Assays 
Work” on page 1-6. In this step, random hexamers from the TaqMan® 
Reverse Transcription Reagents prime total RNA samples for reverse 
transcription using MultiScribe™ Reverse Transcriptase.

In This Chapter The following topics are discussed in this chapter:

Topic See Page

Sample Preparation 2-2

Reverse Transcription for All Amplicons Except 18S 2-4

Reverse Transcription for the 18S Amplicon 2-8

2
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Sample Preparation

Recommended
Template

Based on the template conflicts explained below, Applied Biosystems 
recommends evaluating only human total RNA samples using the 
TaqMan Human Endogenous Control Plate. 

The following table lists the known template incompatibilities:

RNA Template
Preparation and

Quality

Because the quality of results is directly related to the purity of the RNA 
template, Applied Biosystems recommends using only well-purified 
samples with the TaqMan Human Endogenous Control Plate. Because 
ribonuclease and genomic DNA contamination are common problems 
in gene expression studies, purify your samples accordingly to ensure 
the best results.

IMPORTANT Each TaqMan endogenous control assay has been 
experimentally proven not to detect up to 10,000 copies of contaminating DNA. 
In spite of this design characteristic, Applied Biosystems recommends using 
purified total RNA samples to obtain the best results.

Recommended
Quantity

If possible, use spectrophotometric analysis to determine the 
concentrations of your purified total RNA samples. The table below 
contains the recommended range of template quantity.

IMPORTANT Enough sample-specific cDNA must be generated for each 
sample to fill 24 wells on the TaqMan Human Endogenous Control Plate.

Template Explanation

Poly A+ The 18S rRNA assay cannot accurately evaluate poly A+ 
RNA samples, because most of the rRNA has been removed. 

Non-human Except for the 18S rRNA and the internal positive control 
(IPC), all assays on the endogenous control plate are 
human-specific.

Initial Template Quantity Per Wella

a. Initial RNA converted to cDNA

Human Total RNA 10–100 ng



About the
Calibrator Sample

Applied Biosystems recommends evaluating duplicate rows of three 
test samples and a calibrator sample on the TaqMan Human 
Endogenous Control Plate. The figure below illustrates the 
recommended plate configuration.

The calibrator sample serves the following purposes:

♦ Provides a baseline for comparison with the other samples on the 
plate.

♦ Serves as a basis for comparing sample data from multiple, 
independently run plates.

Note The calibrator sample can be used to compare sample data from 
independently run plates only if the same calibrator sample is present on all 
plates.

Sample 3

Sample 1

Sample 2

Calibrator
A

B

C

D

E

F

G

H

1 2 3 4 5 6 7 8 9 10 11 12
Reverse Transcription 2-3
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Reverse Transcription for All Amplicons Except 18S

Reverse
Transcription

Guidelines

The following guidelines ensure optimal RT performance:

♦ Depending on gene expression levels in your samples, Applied 
Biosystems recommends using 10–100 ng of total RNA (converted 
to cDNA) per well. Enough sample-specific cDNA must be 
generated for each sample to fill 24 wells on the TaqMan Human 
Endogenous Control Plate.

♦ Perform multiple RT reactions in multiple wells if using more than 
2 µg total RNA. A maximum of 2 µg total RNA per 100 µL RT 
reaction efficiently converts to cDNA. 

♦ Prior to use, thaw all reagents except the enzyme and the RNase 
Inhibitor. When the reagents are thawed, keep them on ice. 

♦ Keep the MultiScribe Reverse Transcriptase RNase Inhibitor in a 
freezer until immediately prior to use. 

Instruments for
Reverse

Transcription

Because the data acquired during the RT reaction is not needed for 
analysis, any of the thermal cyclers listed below can be used:

♦ ABI PRISM 7700 Sequence Detection System

♦ GeneAmp 5700 Sequence Detection System

♦ GeneAmp® PCR System 9700 Thermal Cycler

♦ GeneAmp® PCR System 9600 Thermal Cycler
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Performing the
RT Reaction

CHEMICAL HAZARD. TaqMan Reverse Transcription 
Reagents may cause eye and skin irritation. Always use adequate ventilation 
such as that provided by a fume hood. Please read the MSDS, and follow the 
handling instructions. Wear appropriate protective eyewear, clothing, and 
gloves.

To perform the RT reaction:

Step Action

1 In a 1.5-mL microcentrifuge tube, prepare a reaction mix for all total 
RNA samples to be reverse transcribed.

Note The calibrator is a sample used as a basis for comparison 
with the other samples on the plate (see “About the Calibrator 
Sample” on page 2-3 for more information).

2 Label four 1.5-mL microcentrifuge tubes for three test samples and 
a calibrator sample.

3 Transfer 60 ng to 2 µg (up to 38.5 µL) of each total RNA sample to 
the corresponding microcentrifuge tube.

CAUTION!

Component

Volume (µL)

Final Conc.
Per 

Sample
Reaction 
Mix (x4)

RNase-free water See 
belowa

a. The volume of RNase-free water (µL) is 38.5 µL–RNA sample volume in 
a 100-µL reaction.

See 
belowa

—

10X RT Buffer 10.0 40.0 1X

25 mM MgCl2 22.0 88.0 5.5 mM

deoxyNTPs Mixture 20.0 80.0 500 µM
(per dNTP)

Random Hexamers 5.0 20.0 2.5 µM

RNase Inhibitor 2.0 8.0 0.4 U/µL

MultiScribe Reverse 
Transcriptase (50 U/µL)

2.5 10.0 1.25 U/µL

Totalb, c

b. If changing the reaction volume, make sure that the final proportions are 
consistent with the recommendd values above.

c. Perform multiple RT reactions in multiple wells if using more than 2 µg 
total RNA.

61.5 246.0 —
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4 If necessary, dilute each total RNA sample to a volume of 38.5 µL 
with RNase-free, deionized water.

5 Cap the tubes and gently tap each to mix the diluted samples.

6 Briefly centrifuge the tubes to eliminate air bubbles in the mixture.

7 Label four 0.2-mL MicroAmp Reaction tubes for the three total RNA 
samples and a calibrator sample.

8 Pipette 61.5 µL of reaction mix (from step 1) into each MicroAmp 
Reaction Tube (from step 7).

9 Transfer 38.5 µL of each dilute total RNA sample to the 
corresponding MicroAmp Reaction tube.

10 Cap the reaction tubes and gently mix the reactions.

11 Breifly centrifuge the tubes to force the solution to the bottom of the 
tube and eliminate air bubbles from the mixture.

12 Transfer each reaction to: 

♦ MicroAmp Optical Tube(s), or

♦ Wells of a MicroAmp Optical 96-Well Reaction Plate.

13 Cap the MicroAmp Optical tubes or plate.

14 Centrifuge the plate or tubes to spin down the contents and 
eliminate air bubbles from the solutions.

To perform the RT reaction: (continued)

Step Action

Sample 3Sample 2Sample 1Calibrator

• 10X RT buffer
• MgCl2
• dNTPs mixture
• Random hexamers
• MultiScribe reverse
   transcriptase
• RNase inhibitor

61.5 µL 61.5 µL 61.5 µL 61.5 µL
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15 Load the reactions into a thermal cycler.

16 Program your thermal cycler with the following conditions:

IMPORTANT If using a 9700 thermal cycler, select MAX Mode to 
perform 100-µL reactions.

Note The thermal cycling parameters are optimal for the Applied 
Biosystems thermal cyclers listed in “Instruments for Reverse 
Transcription” on page 2-4. Due to differences in ramp rates and 
thermal accuracy, you may need to adjust the settings if using 
another thermal cycler. 

Note See your thermal cycler user’s manual for help on setting 
thermal cycling conditions.

17 Load the plate into your thermal cycler and begin thermal cycling.

IMPORTANT Remove the 96-well reaction plate immediately after 
thermal cycling is complete. The cDNA can be used immediately for 
PCR amplification or stored at –15 to –25 °C for later use.

To perform the RT reaction: (continued)

Step Action

Step

Incubation
Reverse 

Transcription

Reverse 
Transcriptase 
Inactivation

HOLD HOLD HOLD

Temperature 25.0 °Ca

a. If using random hexamers or oligo d(T)16 primers for first-strand cDNA 
synthesis, a primer incubation step (25 °C for 10 min) is necessary to 
maximize primer-RNA template binding.

48.0 °C 95.0 °C

Time 10 min 30 min 5 min

Volume 100 µL
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Reverse Transcription for the 18S Amplicon

Overview Synthesis of cDNA from total RNA samples is the first step in the 
two-step RT-PCR gene expression quantification experiment. In this 
step, random hexamers from the TaqMan® Reverse Transcription 
Reagents (P/N N808-0234) prime total RNA samples for reverse 
transcription using MultiScribe™ Reverse Transcriptase.

Recommended
Template

Use only human total RNA samples to generate cDNA for the TaqMan 

Human Endogenous Control Plate. 

The following table lists the known template incompatibilities:

Template Quality The quality of your results is directly related to the purity of your RNA 
template. Therefore, use only well-purified samples with the TaqMan 

Human Endogenous Control Plate. Because ribonuclease and genomic 
DNA contamination are common problems in gene expression studies, 
purify your samples accordingly to ensure the best results.

Template Quantity If possible, use spectrophotometric analysis to determine the 
concentrations of purified total RNA samples before reverse 
transcription. The table below lists the recommended range of initial 
template quantities for the reverse transcription (RT) step.

Template Explanation

Poly A+ The 18S rRNA endogenous control assay cannot accurately 
evaluate cDNA generated from poly A+ RNA samples 
because most of the rRNA has been removed from them. 

Non-human Except for 18S rRNA and the IPC, all assays on the TaqMan 
Human Endogenous Control Plate are human-specific.

Initial Template Quantity of total RNA (per 100-µL RT reaction)

Human Total RNA 60 ng–2 µg
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Guidelines Follow the guidelines below to ensure optimal RT performance:

♦ Poly A+ RNA samples are not recommended for endogenous 
control experiments because most rRNA has been removed from 
them.

♦ A 100-µL RT reaction efficiently converts a maximum of 2 µg total 
RNA to cDNA. Perform multiple RT reactions in multiple wells if 
using more than 2 µg total RNA.

♦ Use only random hexamers to reverse transcribe the total RNA 
samples for endogenous control gene expression assays.

Preparing the
Reactions

The following procedure describes the preparation of three different test 
samples and a calibrator sample for reverse transcription. Scale the 
recommended volumes accordingly for the number of samples needed 
using the TaqMan Reverse Transcription Reagents (P/N N808-0234).

CHEMICAL HAZARD. TaqMan Reverse Transcription 
Reagents may cause eye and skin irritation. Always use adequate ventilation 
such as that provided by a fume hood. Please read the MSDS, and follow the 
handling instructions. Wear appropriate protective eyewear, clothing, and 
gloves.

CAUTION!
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To prepare the reverse transcription reactions:

Step Action

1 In a 1.5-mL microcentrifuge tube, prepare a reaction mix for all total 
RNA samples to be reverse transcribed. 

2 Label four 1.5-mL microcentrifuge tubes for the three test samples 
and a calibrator sample.

3 Transfer 60 ng–2 µg (up to 34.75 µL) of each total RNA sample to 
the corresponding microcentrifuge tube.

4 If necessary, dilute each total RNA sample to a volume of 34.75 µL 
with RNase-free, deionized water.

5 Cap the tubes and gently tap each to mix the diluted samples.

6 Briefly centrifuge the tubes to eliminate air bubbles in the mixture. 

7 Label four 0.2-mL MicroAmp® Reaction Tubes for the three total 
RNA test samples and the calibrator sample.

Component

Volume (µL)

Final 
Conc.

 Per 
Sample 

Reaction 
Mix (x4)

RNase-free water See 
belowa

a. The volume of RNase-free water (µL) is 34.75–RNA sample volume in a 
100-µL reaction.

See 
belowa

—

10X RT Buffer 10.0 40.0 1X

25 mM MgCl2 22.0 88.0 5.5 mM

deoxyNTPs Mixture 20.0 80.0 500 µM 
per dNTP

Random Hexamers 5.0 20.0 2.5 µM

RNase Inhibitor 2.0 8.0 0.4 U/µL

MultiScribe Reverse 
Transcriptase (50 U/µL)

6.25 25.0 3.125 U/µL

Totalb

b. If changing the reaction volume, make sure the final proportions are 
consistent with the recommended values above.

65.25 261.0 —
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8 Pipette 65.25 µL of the reaction mix (from step 1) to each 
MicroAmp Reaction Tube (from step 7).

9 Transfer 34.75 µL of each dilute total RNA sample to the 
corresponding MicroAmp Reaction Tube.

10 Cap the reaction tubes and gently tap each to mix the reactions.

11 Briefly centrifuge the tubes to force the solution to the bottom and to 
eliminate air bubbles from the mixture. 

12 Transfer each reaction to MicroAmp Optical tubes or wells of a 
MicroAmp Optical 96-Well Reaction plate.

13 Cap the MicroAmp Optical tubes or plate.

14 Centrifuge the plate or tubes to spin down the contents and 
eliminate air bubbles from the solutiions.

To prepare the reverse transcription reactions: (continued)

Step Action

Sample 3Sample 2Sample 1Calibrator

• 10X RT buffer
• MgCl2
• dNTPs mixture
• Random hexamers
• MultiScribe reverse
   Transcriptase
• RNase inhibitor

65.25 µL 65.25 µL 65.25 µL 65.25 µL
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Thermal Cycling To conduct reverse transcription thermal cycling:

Step Action

1 Load the reactions into a thermal cycler.

2 Program your thermal cycler with the following conditions:

3 Begin reverse transcription.

IMPORTANT After thermal cycling, store all cDNA samples at 
–15 to –25 °C.

Step
Hexamer 

Incubationa

a. When using random hexamers for first-strand cDNA synthesis, a primer 
incubation step (25 °C for 10 min) is necessary to maximize primer-RNA 
template binding.

Reverse 
Transcription

Reverse 
Transcriptase 
Inactivation

HOLD HOLD HOLD

Temp. 25 °C 37 °C 95 °C

Time 10 min 60 min 5 min

Volume 100 µL
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PCR 3
Overview

About This
Chapter

This chapter covers PCR, or the amplification of cDNA. PCR is the 
second step in the two-step RT-PCR experiment, as described in “How 
TaqMan Endogenous Control Assays Work” on page 1-6. In this step, 
AmpliTaq® Gold DNA polymerase amplifies cDNA synthesized from the 
original total RNA sample. 

Note See “Basics of the 5´ Nuclease Assay” on page 1-7 for more information 
on AmpliTaq Gold DNA polymerase and the 5´ nuclease assay.

In This Chapter The following topics are discussed in this chapter:

Topic See Page

Preparing the Sequence Detection System for PCR 3-2

Preparing and Running the PCR Reactions 3-5

3
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Preparing the Sequence Detection System for PCR

Instruments IMPORTANT Because the data acquired during the PCR is needed for 
analysis, you must use one of the following sequence detectors for PCR:

♦ ABI PRISM 7700 Sequence Detection System

♦ GeneAmp 5700 Sequence Detection System

Configuring the
ABI PRISM 7700
Software for the

VIC Dye

If your ABI PRISM 7700 Sequence Detection System is not calibrated for 
the VIC dye, it must be calibrated using the Sequence Detection 
Systems Spectral Calibration Kit (P/N 4305822). The kit provides the 
standards needed to configure the ABI PRISM 7700 Sequence Detector 
for use with products containing TaqMan® VIC or SYBR® Green dyes. If 
the instrument is not calibrated for the VIC dye, the instrument software 
will be unable to configure the VIC dye layer for the endogenous control 
gene expression assay.

Note For more information about the Sequence Detection Systems Spectral 
Calibration Kit or the calibration procedure, see the ABI PRISM 7700 Sequence 
Detection Systems User Bulletin #4: Generating New Spectra Components 
(P/N 4306234). User bulletin #4 can be obtained from Applied Biosystems. See 
“To Obtain Documents on Demand” on page D-7.

Programming the
Sequence Detector

for PCR

To run the TaqMan Human Endogenous Control Plate on a sequence 
detection system instrument, you must configure a plate document with 
the appropriate assay and sample information. The TaqMan Human 
Endogenous Control Plate compares gene expression levels based on 
the data collected during the PCR run. By configuring the plate 
document with the sample and assay locations, the SDS software can 
collect and organize the florescence data for analysis. 

To configure the PCR plate document:

Step Action

1 Open the Sequence Detection System (SDS) software.

2 Create a plate document with the following attributes:

7700 Plate Document 5700 Plate Document

♦ Single Reporter

♦ 7700 Sequence Detector

♦ Real Time

♦ 5700

♦ 5700 Quantitation
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3 Choose from one of the following:

4 Configure the plate document as shown in the figure below.

Note See Appendix B, “About These Assays,” for a list of target names, abbreviations, and 
descriptions.

To configure the PCR plate document: (continued)

Step Action

If using an… Then…

ABI PRISM 7700 Sequence 
Detection System

From the Dye Layer  menu, select VIC. 

Note If VIC does not appear on the Dye Layer menu, 
the instrument is not calibrated for the VIC dye. See 
“Configuring the ABI Prism 7700 Software for the VIC 
Dye” on page 3-2 for more information.

GeneAmp 5700 Sequence 
Detection System

a. From the Primer/Probe Setup dialog box, create the 
following primer/probe entry:

b. Apply the probe to all wells.

Acronym TAQ1

Description TaqMan VIC
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5 Program the thermal cycler with the following conditions:

Note See your sequence detection systems user’s manual for help on setting thermal 
cycling conditions.

To configure the PCR plate document: (continued)

Step Action

Step

UNG Activationa

a. Required for optimal AmpErase UNG activation.

AmpliTaq Gold 
Activationb

b. Required for optimal AmpliTaq Gold DNA Polymerase activation.

PCR

HOLD HOLD CYCLE (40 cycles)

Denature Anneal/
Extend

Temp. 50.0 °C 95.0 °C 95.0 °C 60.0 °C

Time 2 min 10 min 15 sec 1 min

Volume 50 µL
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Preparing and Running the PCR Reactions

PCR Guidelines The following guidelines ensure optimal PCR performance:

♦ Do not remove the TaqMan Human Endogenous Control Plate from 
its foil packaging until you are ready to load the PCR reaction mix. 
Excessive exposure to light can damage the florescent probes. 

♦ Prior to use, thaw frozen cDNA samples by placing them on ice. 
When thawed, vortex and briefly centrifuge the contents of each 
tube to resuspend the samples.

♦ Prepare PCR reaction mixture for each sample in separate 
microcentrifuge tube before aliquoting it to the reaction plate for 
thermal cycling and fluorescence analysis.

♦ The volume of the PCR reaction mix per well must be 50 µL minus 
the volume of the cDNA sample from the RT step.

♦ Do not mix the PCR mixture and cDNA samples in the MicroAmp 
Optical 96-Well Reaction Plate. 

Note The cDNA amplification reaction is optimized with TaqMan Universal 
PCR Master Mix.

Performing PCR CHEMICAL HAZARD. TaqMan Universal PCR Master Mix 
may cause eye and skin irritation. It may cause discomfort if swallowed or 
inhaled. Always use adequate ventilation such as that provided by a fume hood. 
Please read the MSDS, and follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

CAUTION!
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To perform the PCR: 

Step Action

1 Pipette 650 µL of TaqMan Universal PCR Master Mix (2X) into each 
of 4 microcentrifuge tubes (three test samples and a calibrator 
sample).

2 Dilute three test samples and a calibrator sample from the RT step 
to a volume of 650 µL with RNase-free water. 

IMPORTANT Slowly and carefully remove the caps from the 
reaction plate or tubes to avoid contamination of the reverse 
transcription products.

G
R

14
25

Sample 3Sample 2Sample 1Calibrator

TaqMan PCR
Universal
Master Mix
(2X)

650 µL 650 µL 650 µL 650 µL

Component

Volume (µL)

Well Tube a,b

a.  Volume includes reaction mix for one test sample or the calibrator 
sample (enough to fill 24 wells of the endogenous control plate).

b. Includes volume for 24 wells.

cDNA (from RT step) x y

RNase-free water 25 – x 650 – y

Total volume 25  650
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3 Pipette 650 µL of each cDNA sample to a microcentrifuge tube 
containing TaqMan Universal PCR Master Mix.

4 Cap the microcentrifuge tubes and mix the solutions by gentle 
inversion.

5 Centrifuge the tubes to spin down the contents and eliminate air 
bubbles from the solutions.

To perform the PCR: (continued)

Step Action

Calibrator

Calibrator
+

RNase-free
H2O

650 µL
Universal

Master Mix

650 µL

Sample 1

Sample 1
+

RNase-free
H2O

650 µL
Universal

Master Mix

650 µL

Sample 2

Sample 2
+

RNase-free
H2O

650 µL
Universal

Master Mix

650 µL

Sample 3

Sample 3
+

RNase-free
H2O

650 µL
Universal

Master Mix

650 µL



3-8 PCR

6 Using a positive displacement pipette, transfer the three test 
samples and a calibrator sample 50 µL aliquots to the wells of the 
TaqMan Human Endogenous Control Plate.

7 Seal the wells with MicroAmp Optical Caps or a MicroAmp Optical 
Adhesive Cover.

8 Centrifuge the 96-well plate to spin down the contents and 
eliminate any air bubbles from the solutions.

9 Load the TaqMan Human Endogenous Control Plate into your 
sequence detection system and begin thermal cycling. Refer to the 
thermal cycling conditions on page 3-4.

To perform the PCR: (continued)

Step Action
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Data Analysis 4
Overview

About This
Chapter

This chapter covers data analysis, which requires adjustment of the 
baseline and threshold values within the Sequence Detection Systems 
(SDS) software. After the adjustments, the data can be exported from 
the SDS software for spreadsheet analysis.

IMPORTANT If the threshold value is set before the baseline, the resulting CT 
values may be invalid and produce errors when calculating gene expression.

In This Chapter The following topics are discussed in this chapter:

Topic See Page

Setting the Baseline 4-2

Setting the Threshold Value 4-6

4
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Setting the Baseline

Baseline Basics The baseline is a defined range of cycles before the Sequence 
Detection Systems (SDS) software detects the amplification of PCR 
product. The SDS software uses a default range of cycles 3–15 on 
7700 instruments and cycles 6–15 on 5700 instruments to establish the 
baseline. The figure below illustrates the important characteristics of the 
baseline on a 7700 amplification plot. 

Because of the abundance of rRNA, low CT values can be obtained in 
TaqMan RT-PCR applications with the 18S assays. When the 
amplification of the 18S target reaches a detectable level at a very early 
cycle, it can limit the number of cycles over which the software 
calculates the baseline. In rare cases, this interferes with the detection 
of less abundant targets. See Appendix A, “Troubleshooting Early 
Amplification,” for more information.

Guidelines for
Setting the

Baseline

Correct placement of the baseline is a crucial step in data analysis. 
Follow the guidelines below to ensure the baseline is set properly.

♦ Set the baseline so that the initial amplification curve begins at a 
cycle that is greater than the maximum value of the baseline.

♦ Do not adjust the default baseline if the amplification curve growth 
begins after cycle 15. For example, the default can be used for the 
plot above because initial amplification occurs at cycle 16. 

Cycle Product amplification

Initial amplification 
(baseline must end 
before this point)

Default 7700 baseline
(cycles 3–15)

∆R
n
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Setting the
Baseline for the

ABI PRISM 7700
Instrument

Before setting the baseline, you must first

♦ Display the results on an amplification plot

♦ Change the Y-axis to linear scale

Displaying Results on an Amplification Plot

Changing the Y-Axis to Linear Scale

To display the results on an amplification plot:

Step Action

1 Select Analysis > Analyze.

The SDS software analyzes the raw data and displays an 
amplification plot.

2 If the SDS software does not display an Amplification Plot, then 
select Analysis > Amplification Plot.

The SDS software displays an amplification plot (log ∆Rn vs. 
Cycle).

To change the Y-axis to linear scale:

Step Action

1 Double-click the ∆Rn label on the Y-axis of the amplification plot.

The Scale dialog box appears.

2 Click the Linear Scale radio button to graph the data on a linear 
scale.

3 Click OK. 

The amplification plot appears in a linear scale format.

Double-click here 

Click here 
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Procedure for Setting the Baseline for the ABI PRISM 7700 Instrument

To set the baseline:

Step Action

1 Identify the components of the linear scale amplification plot as 
shown on page 4-2.

2 Click the Stop text field in the Baseline box.

3 Following the guidelines from the previous page, choose from one 
of the following actions:

4 Click Update Calculations.

The SDS software updates the CT and standard deviation values.

Click here

If the amplification plot looks like... Then...

the amplification 
curve begins after 
the maximum 
baseline.

Do not adjust the 
baseline.

the maximum 
baseline is set too 
high.

Decrease the Stop 
baseline value.

the maximum 
baseline is set too 
low. 

Increase the Stop 
baseline value.
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Setting the
Baseline for the
GeneAmp 5700

Instrument

Note For help on setting the baseline, see the GeneAmp 5700 Sequence 
Detection System User’s Manual (P/N 4304472). 

To set the baseline for the GeneAmp 5700 instrument:

Step Action

1 In the Plate window, select all wells for analysis.

2 Select Analysis > Analyze.

An SDS warning message appears.

3 Click OK to continue.

4 In the Plate window, click the Results tab.

Note The tabs just above the wells in the Plate window let you 
toggle between the Setup, Instrument, and Results views.

5 In the Results view, click the Amp Plot tab. 

The Amplification Plot window appears.

6 Identify the components of the linear scale amplification plot as 
shown in “Baseline Basics” on page 4-2.

7 Click the Analysis Preferences button or select Edit > 
Preferences. 

The Preferences dialog box appears.

8 In the Baseline box, highlight the current Start and Stop values and 
type in new values. 

IMPORTANT When selecting a baseline, refer to the guidelines 
listed in “Guidelines for Setting the Baseline” on page 4-2.

9 Click OK.

10 Select Analysis > Analyze. 

The software performs the analysis. The system beeps when the 
analysis is complete.
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Setting the Threshold Value

Threshold Value
Basics

For the 7700 instrument, the default threshold value is the average 
standard deviation of ∆Rn within the defined baseline region, multiplied 
by an adjustable factor. The SDS software calculates the threshold 
value as ten standard deviations from the baseline. For this reason, the 
baseline must be set before you adjust the threshold value. The 
threshold value must be set manually for the 5700 instrument.

The figure below illustrates the important characteristics of the 
threshold on a 7700 plot.

Characteristic Description

1 Product amplification

2 Plateau phase

3 Exponential phase

4 Threshold value

5 Background (spectral noise)

R
n

1

2

3

4

5

Cycle
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Guidelines for
Setting the
Threshold

Note Correct placement of the threshold is a crucial step in data analysis. 
Follow the guidelines below to ensure the threshold is set properly. 

To obtain accurate results:

♦ Set the threshold value within the exponential phase of the 
logarithmic scale amplification plots. The exponential phase occurs 
within the range of data points that increase linearly when graphed.

♦ Set the threshold value so that it is within the exponential phase of 
all amplification plots. If a single threshold cannot be set to satisfy 
all plots, then it must be set multiple times.

Setting Multiple
Thresholds

Because the expression levels and ∆Rn values of TaqMan endogenous 
control assays can vary significantly, it may be necessary to set the 
threshold more than once to obtain accurate results. If a single 
threshold value does not intersect the exponential phase of all 
amplification plots, the data must be analyzed (and subsequently 
exported) with multiple threshold values.

The figure below shows a 5700 amplification plot where the threshold 
must be set independently for each group of curves. As shown, 
Threshold 1 is within the exponential phase of the plots in Group A; 
however, it intersects with the plateau phase of the plots in Group B. 
The results from this setting would be accurate for the plots in Group A, 
but invalid for the plots in Group B. If reset for Group B (Threshold 2), 
the threshold intersects Group A at a point very early in the exponential 
phase where background noise causes non-reproducibility. The 
solution for this situation is to set the threshold separately for both 
groups.
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To set multiple thresholds: 

Step Action

1 Following the appropriate procedure for your instrument, set a 
threshold value that is valid for the majority of plots on the 
logarithmic graph. 

2 Export the data as explained in “Exporting and Viewing the Results 
File” on page 5-2.

The software saves the data to a file.

3 From the logarithmic amplification plot, identify the plots for which 
the threshold set in step 1 was invalid.

4 Reset the threshold value for the second group of plots. 

5 Export the data as explained in “Exporting and Viewing the Results 
File” on page 5-2.

IMPORTANT Save the file with a name different than that used in 
step 2. The software overwrites files with identical names.

There are now two files on the disk:

♦ The file created in step 2 containing valid data for the majority of 
plots from the experiment

♦ The file created in step 5 containing valid data for the remaining 
plots

Note The data in the files is combined later during spreadsheet 
analysis.

10

1

0.1

0.01

0.001
10 20 30 400

∆R
n

Plot Group A

Plot Group B

Threshold 1 
(valid for Group A)

Cycle

Threshold 2 
(valid for Group B)
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Setting the
Threshold Value

for the ABI PRISM

7700 Instrument

Changing the Y-Axis to Logarithmic Scale

Procedure for Setting the Baseline for the ABI PRISM 7700 Instrument

6 Follow the procedure for spreadsheet analysis as described in 
“Calculating the Relative Quantification Using a Spreadsheet” on 
page 5-5.

To set multiple thresholds: (continued)

Step Action

To view the threshold value: 

Step Action

1 Double-click the ∆Rn label on the Y-axis of the graph.

The Scale dialog box appears.

2 Click the Logarithmic Scale radio button from the Display box.

3 Click OK. 

The amplification plot appears in logarithmic format.

To set the threshold value: 

Step Action

1 Identify the components of the amplification curve as shown in 
“Threshold Value Basics” on page 4-6.

2 Click and drag the threshold line so that it is:

♦ Above the background noise

♦ Below the plateaued region

♦ Within the exponential phase of the amplification curve

Click here 
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Note To reset the threshold to the default value, click the Suggest button 
in the Threshold box.

3 Click Update Calculations.

The SDS software updates the CT and standard deviation values.

4 Click OK.

To set the threshold value: (continued)

Step Action

Above the 
background 

Within this range

Below the 
plateaued region

Click here
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Setting the
Threshold Value

for the GeneAmp
5700 Instrument

Note For help on setting the threshold value, see the GeneAmp 5700 
Sequence Detection System User’s Manual (P/N 4304472). 

To set the threshold for the GeneAmp 5700 instrument: 

Step Action

1 In the Plate window, click the Results tab.

Note The tabs just above the wells in the Plate window let you 
toggle between the Setup, Instrument, and Results views.

2 In the Results view, click the Amp Plot tab. 

The Amplification Plot window appears.

3 Identify the components of the amplification curve as shown in 
“Threshold Value Basics” on page 4-6.

4 Determine a value for threshold that is:

♦ Above the background noise

♦ Below the plateaued region

♦ Within the exponential phase of the amplification curve

IMPORTANT When selecting a threshold, refer to the guidelines 
listed in “Guidelines for Setting the Threshold” on page 4-7.

5 Click the Analysis Preferences button, or select Edit > 
Preferences. 

The Preferences dialog box appears.

6 In the Threshold box, enter the value you determined in step 4 
above. 

7 Click OK.

8 Select Analysis > Analyze . 

The software performs the analysis. The system beeps when the 
analysis is complete.
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Calculating Relative 
Quantification 5
Overview

About This
Chapter

This chapter explains how to calculate relative quantification values 
from CT values with the use of a spreadsheet application such as 
Microsoft® Excel. Applied Biosystems® recommends using a 
professional spreadsheet software package to analyze the results from 
the TaqMan Human Endogenous Control Plate. Although calculation of 
relative quantification values can be done manually, spreadsheet 
packages speed the process considerably.

In This Chapter The following topics are discussed in this chapter:

Topic See Page

Exporting and Viewing the Results File 5-2

Calculating the Relative Quantification Using a Spreadsheet 5-5

Interpreting Results 5-17

5
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Exporting and Viewing the Results File

Creating a
Results File

To analyze data from the TaqMan Human Endogenous Control Plate, 
export the results to a results file. The SDS software can export raw 
data from a sequence detection run in formats that are compatible with 
most spreadsheet applications. The type of file the software exports 
depends on the model instrument used to collect the data.

Exporting Results from a GeneAmp 5700 Sequence Detection System

The figure below is an example of an exported 5700 results file as 
viewed with the Microsoft Excel spreadsheet.

Instrument Exported Format

ABI PRISM 7700 Instrument Tab-delimited text file

GeneAmp 5700 Instrument Comma-separated text file (.csv)

To export the data from the endogenous control gene expression assay:

Step Action

1 Select Analysis > Export > Ct.

The Save As dialog box appears.

Note You can also click the Export button in the Report window 
to open the Save As dialog box.

2 Click the Save as text box and type a name for the results file.

3 Click Save.

The SDS software exports the data to a comma-separated text file.

4 Close the SDS software.
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Exporting Results from a ABI PRISM 7700 Sequence Detection System

The figure below is an example of an exported 7700 results file as 
viewed with the Microsoft Excel spreadsheet.

To export the data from the endogenous control gene expression assay:

Step Action

1 Select File > Export > Results.

2 Click the Export result data as text box and type a name for the 
file.

3 Click the Export All Wells radio button.

The software saves the data from all wells to the results file.

4 Click Export.

The SDS software exports the data to a Microsoft Excel 
spreadsheet.

5 Close the SDS software.

Click here
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Viewing the
Results File

The exported SDS file from the data analysis procedure can be viewed 
using almost any spreadsheet application. 

To view the exported results file: 

Step Action

1 Open the spreadsheet software.

2 Select File > Open.

3 Select from one of the following: 

If you created… Then select the…

one results file exported results file and click 
Open .

two results files as explained 
in the “Setting Multiple 
Thresholds” on page 4-7

exported file created in 
steps 1–2 and click Open.

two results files as explained 
in “How to Correct for Early 
Amplification” on page A-2

exported file created in 
steps 1–4 and click Open.



Calculating Relative Quantification 5-5

Calculating the Relative Quantification Using a Spreadsheet

Overview Applied Biosystems recommends using a spreadsheet to create 
comparative gene expression profiles from TaqMan Human 
Endogenous Control Plate data.

Constructing a
CT Table

To construct a CT table:

Step Action

1 Select File > New.

A new spreadsheet appears.

2 From the Window menu, select the results file.

The endogenous control plate results spreadsheet reappears.

3 Select cells A2–A13 . 

4 Select Edit  > Copy . 

5 From the Window  menu, select the new spreadsheet.

The new spreadsheet file reappears.

6 Click cell A2.

7 Select Edit  > Paste .

Excel pastes the data into the new spreadsheet.
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8 Type the labels for the CT table as specified in the following table. 

The ∆CT table appears as shown below.

To construct a CT table: (continued)

Step Action

Click on cell… Type…

A1 Column

B1 Ct Calibrator

C1 Ct Calibrator

D1 Ct Sample 1

E1 Ct Sample 1

F1 Ct Sample 2

G1 Ct Sample 2

H1 Ct Sample 3

I1 Ct Sample 3



Calculating Relative Quantification 5-7

Importing Data to
the CT Table

Note This section also consolidates the data from additional files created in 
the sections:

♦ “Setting Multiple Thresholds” on page 4-7

♦ Appendix A, “Troubleshooting Early Amplification.”

To transfer data from the results file to the CT table:

Step Action

1 From the Window menu, select the exported results file.

The endogenous control plate results spreadsheet reappears.

2 From the results file spreadsheet select:

Note The columns of the selected cells contain the CT values for the wells in row A of the 
TaqMan Human Endogenous Control Plate.

3 Select Edit > Copy. 

4 From the Window menu, select the new spreadsheet.

The new spreadsheet file reappears.

5 Click on cell B2.

6 Select Edit > Paste.

Excel pastes the data into the new spreadsheet.

7 Using the cut-and-paste procedure from steps 1–6, copy the CT values of the remaining wells 
into the new spreadsheet as shown below.

If viewing a… Select cells…

5700 results file D2–D13

7700 results file F2–F13

Select and copy the following cells…

Paste to cells… 5700 results file 7700 results file

D14–D25 F14–F25 C2–C13

D26–D37 F26–F37 D2–D13

D38–D49 F38–F49 E2–E13

D50–D61 F50–F61 F2–F13

D62–D73 F62–F73 G2–G13

D74–D85 F74–F85 H2–H13

D86–D97 F86–F97 I2–I13
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8 Choose one of the following:

To transfer data from the results file to the CT table: (continued)

Step Action

If the baseline and/or 
threshold values were set... Then...

once for all targets go to “Deleting Invalid CT Values” on page 5-10.

separately for the targets as 
done in:

♦ “Setting Multiple 
Thresholds” on page 4-7,
or

♦ Appendix A, 
“Troubleshooting Early 
Amplification.”

using the figure below as a reference, replace the CT 
values for the invalid wells as follows:

a. Open the second results file.

b. Copy and paste the CT values of the valid wells from 
the second file to the CT table, replacing the invalid 
values from the first results file.

c. “Deleting Invalid CT Values” on page 5-10.
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The following figures illustrate the placement of the well data in the CT table. As shown, the cells in the 
CT table correspond to the 96 wells of the TaqMan Human Endogenous Control Plate.

To transfer data from the results file to the CT table: (continued)

Step Action

Sample 3

Sample 1

Sample 2

Calibrator
A

B

C

D

E

F

G

H

1 2 3 4 5 6 7 8 9 10 11 12

1 2 3 4 5 6 7 8 9 10 11 12

13 14 15 16 17 18 19 20 21 22 23 24

25 26 27 28 29 30 31 32 33 34 35 36

37 38 39 40 41 42 43 44 45 46 47 48

49 50 51 52 53 54 55 56 57 58 59 60

61 62 63 64 65 66 67 68 69 70 71 72

73 74 75 76 77 78 79 80 81 82 83 84

85 86 87 88 89 90 91 92 93 94 95 96

Well numbers 
correspond to 
the numbered 
wells on the 
TaqMan Human 
Endogenous 
Control Plate
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Deleting Invalid
CT Values

Before averaging the CT values of duplicate wells, clear the data for all 
wells containing values outside the given dynamic range of the assays. 
Invalid CT values may be the result of experimental error (degraded 
samples, pipetting inaccuracy). If averaged using the CT values from 
the duplicate wells, the invalid data can skew the results and indicate an 
incorrect level of gene expression.

Guidelines for Deleting Invalid CT Values

Use the following guidelines to identify invalid data for deletion:

How to Delete Invalid CT Values

Guideline Description

Use the 18S rRNA 
assay as an indicator 
of sample 
concentration and 
quality

Because cells generally express 18S rRNA at extremely high levels, the 
target is usually a good indicator of sample concentration. Typically, the 18S 
assay yields CT values ≤ 22. If sample produces CT values above 22 for the 
18S assay, it may not contain enough cDNA for accurate analysis. 
Therefore, the sample must be cleared from the spreadsheet as shown 
below.

Look for individual 
outlying CTs

Occasionally, a single well produces a CT outside the average for its target 
group. Abnormalities of this kind are typically due to experimental error 
rather than differences in gene expression. To obtain accurate CT values for 
the sample, the CT must be cleared from the spreadsheet as shown below. 

The calibrator data 
must be deleted 
because the CT 
values for the 18S 
assay (cells B2 and 
C2) are greater than 
22 cycles.

This value is 
beyond the average 
CT for this row and 
must be deleted.

To delete an invalid CT value from the spreadsheet: 

Step Action

1 Click the cell containing an invalid CT to select it.

2 Select Edit > Clear > All.
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Averaging
Duplicate CT

Values

Before calculating ∆CT values for the calibrator and samples, average 
the CT values from duplicate wells. Because the samples and calibrator 
are arrayed twice across the endogenous control plate, the exported 
data for every sample contains two CT values for each target control. To 
calculate ∆CT values, you must average the values for these duplicate 
wells.

To add Average CT columns to your CT table:

Step Action

1 Create columns for the average calibrator and sample CT values by inserting new columns 
into the spreadsheet as follows:

2 Type the labels for the CT table as specified in the following table: 

Click cell… Select…

D1 Select Insert  > Columns .

Excel inserts a new column before column D.

G1 Select Insert  > Columns .

Excel inserts a new column before column G.

J1 Select Insert  > Columns .

Excel inserts a new column before column J.

Click on cell… Type…

D1 Avg Ct Calibrator

G1 Avg Ct Sample 1

J1 Avg Ct Sample 2

M1 Avg Ct Sample 3
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3 Average the CT values of duplicate calibrator and sample wells by typing the following 
formulas into the specified cells:

4 Copy the formulas entered into the spreadsheet in the previous step and paste them to the 
remaining cells of each column, as follows:

Excel averages the CT values for the two cells to the left of each copied cell and displays the averaged 
CT.

To add Average CT columns to your CT table: (continued)

Step Action

Click cell… Type…

D2 =AVERAGE(B2:C2)

Excel averages the CT values of cells B2 and C2 and displays it in cell D2.

G2 =AVERAGE(E2:F2)

Excel averages the CT values of cells E2 and F2 and displays it in cell G2.

J2 =AVERAGE(H2:I2)

Excel averages the CT values of cells H2 and I2 and displays it in cell J2.

M2 =AVERAGE(K2:L2)

Excel averages the CT values of cells K2 and L2 and displays it in cell M2.

Select and copy cell… Paste to cells…

D2 D3–D13

G2 G3–G13

J2 J3–J13

M2 M3–M13

Average CT values 
of duplicate 
calibrator wells

Average CT values 
of duplicate wells 
for Sample 1

Average CT values 
of duplicate wells 
for Sample 2

Average CT values 
of duplicate wells 
for Sample 3



Calculating Relative Quantification 5-13

About the ∆CT
Equation

Derivation of ∆CT values from the average CT values of the calibrator 
and samples is the final step in comparative gene expression analysis. 
The following equation describes the ∆CT calculation.

The equation above uses the average CT of the calibrator as a baseline 
for evaluating target gene expression in each sample. 

♦ Samples with initial template concentrations higher than the 
calibrator have lower average CT values and yield positive 
numbers. 

♦ Samples with lower initial template concentrations have higher 
average CT values and yield negative numbers.

Constructing a
∆CT Table

CT Sample( )∆ AverageCT Calibrator( ) AverageCT Sample( )–=

To construct a ∆CT table:

Step Action

1 Copy cells A1–A13  and paste into cells A16–A28 . 

Copy 
and 
Paste
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2 Type the following labels into the specified cells in the table:

3 Type the following ∆CT labels into the specified cells in the table:

The ∆CT table appears as shown below.

To construct a ∆CT table: (continued)

Step Action

Click on cell… Type…

B16 Target

B17 IPC

B18 18S

B19 huPO

B20 huBA

B21 huCYC

B22 huGAPDH

B23 huPGK

B24 huB2m

B25 huGUS

B26 huHPRT

B27 huTBP

B28 huTfR

Click on cell… Type…

C16 ∆Ct Sample 1

D16 ∆Ct Sample 2

E16 ∆Ct Sample 3

F16 Average ∆Ct

G16 ∆Ct Calibrator
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Calculating ∆CT
Values

To calculate ∆CT values for the calibrator and samples:

Step Action

1 Type the following formulas into the specified cells:

The ∆CT table appears as shown below.

Click cell… Type…

C17 =D2–G2

Excel subtracts the averaged CT value for 
Sample 1 (cell G2) from the averaged CT value 
for the calibrator (cell D2).

D17 =D2–J2

Excel subtracts the averaged CT value for 
Sample 2 (cell J2) from the averaged CT value 
for the calibrator (cell D2).

E17 =D2–M2

Excel subtracts the averaged CT value for 
Sample 3 (cell M2) from the averaged CT value 
for the calibrator (cell D2).

F17 =AVERAGE(C17:D17:E17)

Excel averages ∆CT values for the three 
samples yielding an overall mean for the IPC 
endogenous control.

G17 =D2–D2

Excel subtracts the averaged calibrator CT 
(cell D2) from itself to verify the calibrator.
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2 Select and copy cells C17–G17.

Excel changes the boarder of the selected cell to a dotted line 
indicating that the cell is ready for duplication.

3 Select cells F18–G28 and paste the selection into the spreadsheet.

Excel automatically copies the formulas in cells C17–G17 to the cells below.

To calculate ∆CT values for the calibrator and samples: (continued)

Step Action
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Interpreting Results

Overview To interpret the results from the spreadsheet analysis, create a profile of 
control gene expression from the data in the ∆CT table.

Interpreting results consists of the following steps:

Generating a Gene
Expression Profile

The following procedure describes how to generate a profile using the 
Excel Chart Wizard. 

Topic See Page

Generating a Gene Expression Profile 5-17

Interpreting the Gene Expression Profile 5-18

The Relationship Between ∆CT and Gene Expression 5-18

Choosing an Endogenous Control 5-19

Demonstrating Performance with TaqMan Human Control Total 
RNA

5-20

To graph your results using the Excel Chart Wizard: 

Step Action

1 Select cells A16–E28.

2 Select Insert > Chart  > On This Sheet .

The Excel chart wizard requests data for the new graph.

3 Click the selected data.

The chart wizard prompts you for information.

4 Follow the instructions as directed by the wizard. 
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Interpreting the
Gene Expression

Profile

The results of the Endogenous Control Plate are expressed in ∆CT, 
greater than or less than the calibrator ∆CT. Thus, the calibrator serves 
as a baseline for the assays and is shown as zero on the graph. 

♦ Samples with positive ∆CT values have initial template 
concentrations higher than that of the calibrator sample. 

♦ Samples with negative ∆CT values have initial template 
concentrations lower than that of the calibrator sample. 

Note See “About the ∆CT Equation” on page 5-13 for more information.

The plot below illustrates a typical gene expression profile.

The Relationship
Between ∆CT and
Gene Expression

One ∆CT is equal to a twofold difference in initial template 
concentration. This relationship is shown with the following equation:

Because amplicons designed and optimized according to Applied 
Biosystems guidelines have equivalent efficiencies approaching 100%, 
it can be stated that EX = 1. Also, because we are interested in the 
difference in initial template for one cycle, it can be stated that n = 1. 
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Where:

Xn = Copy number at cycle n EX = Amplicon efficiency

X0 = Copy number at cycle 0 n = Cycle number

Xn X0 1 EX+( )n=
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Substituting values for the appropriate variables, the equation 
becomes:

Choosing an
Endogenous

Control

Choose the control with the least variation in ∆CT levels. Ideally, the 
best control is expressed at a constant level in all samples regardless of 
cell cycle, cell type, or tissue. Because the ∆CT indicates the level of 
gene expression relative to the calibrator, the ∆CT values of a good 
control do not vary much from zero. It is important to remember that a 
difference of one cycle equates to a twofold difference in initial 
template. For example, a control with ∆CT values that vary over a two 
cycle range would have nearly a fourfold difference in expression 
levels. Stable expression provides a reliable basis for comparison with 
other genes.

Good Endogenous Control Candidates

From the ∆CT profile shown below, the 18S ribosomal RNA (18S) and 
transferrin receptor (huTfR) genes are good candidate controls 
because their expression remains relatively consistent across the test 
samples. Both assays produced ∆CT values that deviate little from zero, 
indicating a fairly stable level of gene expression relative to the other 
candidate controls.

Poor Endogenous Control Candidates

In contrast to the 18S and huTfR controls, the TATA-binding protein 
(huTBP) and β-Glucronidase (huGUS) genes are the least desirable 
choices from the profile in the figure below. The expression of both 
controls vary widely, exhibiting ∆CT values that fluctuate in excess of 
4 cycles (this represents a 16-fold difference in gene expression). 

X1 X0 1 1+( )1 2X0= =
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Demonstrating
Performance with

TaqMan Human
Control Total RNA

TaqMan Human Control Total RNA is available to demonstrate the 
performance of the TaqMan Human Endogenous Control Plate. The 
figure below shows a typical gene expression profile for the sample.
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To generate the profile shown above: 

Step Action

1 Perform the reverse transcription step as described in “Reverse 
Transcription for All Amplicons Except 18S” on page 2-4 using the 
TaqMan Human Control Total RNA (10 ng per well).

2 Perform the PCR step as described in Chapter 3, “PCR,” 
configuring the plate with duplicate wells for the control sample.

3 Analyze and export the data. See Chapter 4, “Data Analysis.”

4 Construct a ∆CT table and import data to it by following the 
procedures on pages 5-4 to 5-7.

5 Select the column of cells containing the CT data for the Human 
Control Total RNA.

6 Select Insert > Chart > On This Sheet.

7 Click the selected data.

8 Follow the instructions as directed by the wizard. 
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Troubleshooting Early 
Amplification A

Effects of Early
Amplification of

the 18S Assay

In rare cases, the amplification of the 18S assay can interfere with the 
detection of less abundant targets. When amplification of the 18S target 
reaches a detectable level at a very early cycle, it limits the number of 
cycles over which the software can calculate the baseline. As the 
available baseline is compressed, the amplification plots of the less 
abundant targets may appear to disperse. This can lead to poor 
reproducibility and inaccurate quantification.

For example, in the figure below the baseline is set correctly for the 18S 
amplification (baseline is set for cycles 2–7), however the plots of the 
less abundant targets have become dispersed. As a result, CT values 
from this plot are valid only for the 18S amplifications. 

The baseline in the figure below is reset for the less abundant targets 
(baseline is set for cycles 3–15). Notice that the amplification plots of 
these targets are now well pronounced and allow the SDS software to 
determine accurate CT values. In contrast, the plots of 18S targets now 
exhibit a sigmoidal curve and do not yield valid data points.

Plots of the 18S rRNA 
target 

Plots of less abundant 
targets (dispersed)

Baseline (cycles 2–7)

A
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How to Correct
for Early

Amplification

When early amplification of the 18S rRNA target interferes with the 
detection of less abundant genes, set the baseline and threshold values 
independently for each group of plots. The following procedure explains 
how to configure each group of plots independently and export the data. 
The results from the results files are combined during spreadsheet 
analysis.

Plots of less abundant 
targets

Plots of the 18S rRNA 
target

Baseline (cycles 3–15)

To set the baseline and threshold separately: 

Step Action

1 From the amplification plot, deselect the 18S wells that amplify 
during the very early cycles of the PCR.

2 Following the guidelines in “Guidelines for Setting the Baseline” on 
page 4-2, set the baseline for those plots that amplify during the 
later cycles of the PCR.

3 Following the guidelines in “Guidelines for Setting the Threshold” on 
page 4-7, set the threshold for the plots that amplify during the later 
cycles of the PCR.

4 Export the data as explained in “Exporting and Viewing the Results 
File” on page 5-2.

The software saves the data. The results in the file are valid only for 
the wells that amplify during the later cycles. 

5 From the amplification plot, deselect the wells that amplify during 
the later cycles of the PCR.

6 Following the guidelines in “Guidelines for Setting the Baseline” on 
page 4-2, reset the baseline for the 18S wells that amplify during 
the very early cycles of the PCR.

7 Following the guidelines in “Guidelines for Setting the Threshold” on 
page 4-7, set threshold for the 18S wells that amplify during the 
very early cycles of the PCR.
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8 Export the data as explained in “Exporting and Viewing the Results 
File” on page 5-2.

The software saves the data. The results in the file are valid only for 
the wells that amplify during the very early cycles. 

You now have two results files:

♦ A file containing valid data for plots appearing in the later cycles

♦ A file containing valid data for plots appearing in the early cycles

9 Follow the procedure for spreadsheet analysis as described in 
“Calculating the Relative Quantification Using a Spreadsheet” on 
page 5-5.

To set the baseline and threshold separately: (continued)

Step Action
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About These Assays B
Overview The TaqMan Human Endogenous Control Plate evaluates the 

expression of eleven common “housekeeping” genes and an internal 
positive control in total RNA samples. Applied Biosystems designed 
TaqMan assay primers and probes to be cDNA specific to avoid 
problems associated with pseudogenes, related genes, and 
contaminant genomic DNA. 

Quality Control Applied Biosystems tests the preloaded primers and probes on the 
TaqMan Human Endogenous Control Plate as part of a manufacturing 
quality control process. In this process, the performance of each 
endogenous control target was gauged using cDNA prepared from 
human total RNA samples. Each assay demonstrated that it did not 
detect up to 10,000 copies of contaminating genomic DNA.

Description of
Endogenous

Controls

The following table lists the potential controls and their cellular 
functions:

Endogenous 
Control Role

IPC Applied Biosystems designed the TaqMan Exogenous Internal Positive Control 
(IPC) to help interpret negative results caused by PCR inhibitors. In the absence 
of inhibitors, IPC co-amplifies with target DNA and gives a specific signal. The 
IPC sequence is artificial so that PCR primers do not amplify anything in the test 
samples.

18S rRNA 18S ribosomal RNA makes up 80% of total RNA and its level is a good indicator 
for the relative amount of total RNA. It is transcribed by a different polymerase 
from mRNAs and its level is less likely to fluctuate with the test sample. The 18S 
rRNA endogenous reference is the most abundant target on the TaqMan Human 
Endogenous Control Plate.

B
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Acidic ribosomal 
protein (huPO)

Acidic ribosomal protein is moderately abundant (Rich et al., 1987) and found in 
most tissue types. Because huPO gene expression level seems to remain 
relatively constant (Okubo et al., 1997), some researchers select it as their 
standard when studying samples that are affected by estrogen treatment.

Beta-actin 
(huβA)

The beta-actin gene is ubiquitously expressed in all eukaryotic cells and one of 
the most frequently used as an internal standard. It is a moderately abundant 
gene, constituting 0.1% of mRNA and 0.003% of total RNA. Its level fluctuates in 
some cells and tissues (Greenberg et al., 1985; Dodge et al., 1990). Actins are 
highly conserved proteins involved in various types of cell motility. 

Cyclophilin 
(huCYC)

Cyclophilin is a major cellular component, comprising 0.1–0.4% of total cellular 
protein. It is found in all cells of wide phylogenetic distribution (Koletsky et al., 
1986). It was originally isolated as the main cyclosporin A binding protein.

Glyceraldehyde- 
3-phosphate 

dehydrogenase 
(huGAPDH)

GAPDH is a key enzyme involved in glycolysis and is moderately abundant 
(Allen et al., 1987). Its expression changes with insulin treatment and shows 
fluctuation through cell cycles and among different cell lines and tissue types.

Phosphoglycero-
kinase (huPGK)

PGK is a key enzyme involved in glycolysis following GAPDH. Because typical 
concentrations of glycolytic intermediates are 1 µM for 1,3-bisphosphoglycerate 
and 118 µM for 3-phosphoglycerate, the regulation may be different.

β2-Microglobulin 
(huβ2m)

 β2-microglobulin is involved with immune response. It is moderately abundant 
and expressed in most tissue types (Güssow et al., 1987). The level of 
β2-microglobulin expression may vary in different tissues (Okubo et al., 1997).

β-Glucronidase 
(huGUS)

β-glucronidase is a relatively abundant glycoprotein that is expressed 
constitutively in many tissues. It acts as an exoglycosidase in lysomes 
(Oshima et al., 1988).

Hypoxanthine 
ribosyl 

transferase 
(huHPRT)

Hypoxanthine ribosyl transferase is located on the X chromosome and is 
constitutively expressed at low levels (Patel et al., 1986). It plays an important 
role in the metabolic salvage of purines in mammalian cells.

Transcription 
Factor IID, TATA 
Binding Protein 

(huTBP)

The TATA binding protein is constitutively expressed in many tissues and cells at 
low levels. It is required for transcription directed by RNA polymerases I, II, and III 
(Chalut et al., 1995).

Transferrin 
Receptor 
(huTfR)

Transferrin receptor mediates cellular iron uptake and is expressed at low levels 
in both tissues and cells. The expression of the receptor on the cell surface 
correlates with cellular proliferation, being highest on rapidly dividing cells and 
much lower on resting cells and more terminally differentiated cell types 
(McClelland et al.,1984). As shown in the figure in “Demonstrating Performance 
with TaqMan Human Control Total RNA” on page 5-20, transferrin receptor 
exhibits the lowest level of gene expression when evaluating TaqMan Human 
Control Total RNA using the TaqMan Human Endogenous Control Plate.

Endogenous 
Control Role
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Technical Support D
Technical Support

Contacting
Technical Support

You can contact Applied Biosystems for technical support by telephone 
or fax, by e-mail, or through the Internet. You can order Applied 
Biosystems user documents, MSDSs, certificates of analysis, and other 
related documents 24 hours a day. In addition, you can download 
documents in PDF format from the Applied Biosystems Web site 
(please see the section “To Obtain Documents on Demand” following 
the telephone information below).

To Contact
Technical Support

by E-Mail

Contact technical support by e-mail for help in the following product 
areas:

Product Area E-mail address

Genetic Analysis (DNA Sequencing) galab@appliedbiosystems.com

Sequence Detection Systems and 
PCR

pcrlab@appliedbiosystems.com

Protein Sequencing, 
Peptide and DNA Synthesis

corelab@appliedbiosystems.com

♦ Biochromatography
♦ PerSeptive DNA, PNA and 

Peptide Synthesis systems
♦ FMAT™  8100 HTS System
♦ CytoFluor® 4000 Fluorescence 

Plate Reader
♦ Voyager™Mass Spectrometers
♦ Mariner™ Mass Spectrometers

tsupport@appliedbiosystems.com

LC/MS (Applied Biosystems/MDS 
Sciex)

support@sciex.com

Chemiluminescence (Tropix) tropix@appliedbiosystems.com

D
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Hours for
Telephone

Technical Support

In the United States and Canada, technical support is available at the 
following times:

Product Hours

Chemiluminescence 8:30 a.m. to 5:30 p.m. Eastern Time

Framingham support 8:00 a.m. to 6:00 p.m. Eastern Time

All Other Products 5:30 a.m. to 5:00 p.m. Pacific Time
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To Contact
Technical Support

by Telephone or
Fax

In North America

To contact Applied Biosystems Technical Support, use the telephone or 
fax numbers given below. (To open a service call for other support 
needs, or in case of an emergency, dial 1-800-831-6844 and press 1.)

Product or
Product Area

Telephone
Dial...

Fax
Dial...

ABI PRISM® 3700 DNA 
Analyzer

1-800-831-6844,
then press 8

1-650-638-5981

DNA Synthesis 1-800-831-6844,
then press 2, then 1

1-650-638-5981

Fluorescent DNA 
Sequencing

1-800-831-6844,
then press 2, then 2

1-650-638-5981

Fluorescent Fragment 
Analysis (includes 
GeneScan® applications)

1-800-831-6844,
then press 2, then 3

1-650-638-5981

Integrated Thermal Cyclers 
(ABI PRISM® 877 and 
Catalyst 800 instruments)

1-800-831-6844,
then press 2, then 4

1-650-638-5981

ABI PRISM® 3100 Genetic 
Analyzer

1-800-831-6844,
then press 2, then 6

1-650-638-5981

Peptide Synthesis (433 and 
43X Systems)

1-800-831-6844,
then press 3, then 1

1-650-638-5981

Protein Sequencing 
(Procise Protein 
Sequencing Systems)

1-800-831-6844,
then press 3, then 2

1-650-638-5981

PCR and Sequence 
Detection

1-800-762-4001,
then press 1 for 
PCR,
2 for the 7700, 7900 
or 5700,
6 for the 6700
or dial 
1-800-831-6844, then 
press 5

1-240-453-4613

♦ Voyager MALDI-TOF 
Biospectrometry

♦ Mariner ESI-TOF Mass 
Spectrometry 
Workstations

1-800-899-5858,
then press 1, then 3

1-508-383-7855
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Outside North America

Biochromatography 
(BioCAD Workstations and 
POROS Perfusion 
Chromatography Products)

1-800-899-5858,
then press 1, then 4

1-508-383-7855

Expedite Nucleic acid 
Synthesis Systems

1-800-899-5858,
then press 1, then 5

1-508-383-7855

Peptide Synthesis 
(Pioneer and 9050 Plus 
Peptide Synthesizers)

1-800-899-5858,
then press 1, then 5

1-508-383-7855

PNA Custom and Synthesis 1-800-899-5858,
then press 1, then 5

1-508-383-7855

♦ FMAT 8100 HTS 
System

♦ Cytofluor 4000 
Fluorescence Plate 
Reader

1-800-899-5858,
then press 1, then 6

1-508-383-7855

Chemiluminescence 
(Tropix)

1-800-542-2369 (U.S. 
only),
or 1-781-271-0045

1-781-275-8581

LC/MS (Applied 
Biosystems/MDS Sciex)

1-800-952-4716 1-508-393-7899

Region
Telephone
Dial...

Fax
Dial...

Africa and the Middle East

Africa (English Speaking) 
and West Asia (Fairlands, 
South Africa)

27 11 478 0411 27 11 478 0349

Africa (French Speaking; 
Courtaboeuf Cedex, 
France)

33 1 69 59 85 11 33 1 69 59 85 00

South Africa 
(Johannesburg)

27 11 478 0411 27 11 478 0349

Middle Eastern Countries 
and North Africa (Monza, 
Italia)

39 (0)39 8389 481 39 (0)39 8389 493

Product or
Product Area

Telephone
Dial...

Fax
Dial...
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Eastern Asia, China, Oceania

Australia (Scoresby, 
Victoria)

61 3 9730 8600 61 3 9730 8799

China (Beijing) 86 10 64106608 or
86 800 8100497

86 10 64106617

Hong Kong 852 2756 6928 852 2756 6968

India (New Delhi) 91 11 653 3743/3744 91 11 653 3138

Korea (Seoul) 82 2 593 6470/6471 82 2 593 6472

Malaysia (Petaling Jaya) 60 3 79588268 603 79549043

Singapore 65 896 2168 65 896 2147

Taiwan (Taipei Hsien) 886 2 2358 2838 886 2 2358 2839

Thailand (Bangkok) 66 2 719 6405 66 2 319 9788

Europe

Austria (Wien) 43 (0)1 867 35 75 0 43 (0)1 867 35 75 11

Belgium 32 (0)2 532 4484 32 (0)2 582 1886

Czech Republic and 
Slovakia (Praha)

420 2 35365189 420 2 35364314

Denmark (Naerum) 45 45 58 60 00 45 45 58 60 01

Finland (Espoo) 358 (0)9 251 24 250 358 (0)9 251 24 243

France (Paris) 33 (0)1 69 59 85 85 33 (0)1 69 59 85 00

Germany (Weiterstadt) 49 (0) 6150 101 0 49 (0) 6150 101 101

Hungary (Budapest) 36 (0)1 270 8398 36 (0)1 270 8288

Italy (Milano) 39 (0)39 83891 39 (0)39 838 9492

Norway (Oslo) 47 23 12 06 05 47 23 12 05 75

Poland, Lithuania, Latvia, 
and Estonia (Warszawa)

48 (22) 866 40 10 48 (22) 866 40 20

Portugal (Lisboa) 351 (0)22 605 33 14 351 (0)22 605 33 15

Russia (Moskva) 7 502 935 8888 7 502 564 8787

South East Europe (Zagreb, 
Croatia)

385 1 34 91 927/838 385 1 34 91 840

Spain (Tres Cantos) 34 (0)91 806 1210 34 (0)91 806 1206

Sweden (Stockholm) 46 (0)8 619 4400 46 (0)8 619 4401

Switzerland (Rotkreuz) 41 (0)41 799 7777 41 (0)41 790 0676

Region
Telephone
Dial...

Fax
Dial...
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To Reach
Technical Support

Through the
Internet

We strongly encourage you to visit our Web site for answers to 
frequently asked questions and for more information about our 
products. You can also order technical documents or an index of 
available documents and have them faxed or e-mailed to you through 
our site. The Applied Biosystems Web site address is

http://www.appliedbiosystems.com/techsupp

The Netherlands 
(Nieuwerkerk a/d IJssel)

31 (0)180 392400 31 (0)180 392409 or
31 (0)180 392499

United Kingdom 
(Warrington, Cheshire)

44 (0)1925 825650 44 (0)1925 282502

All other countries not listed 
(Warrington, UK)

44 (0)1925 282481 44 (0)1925 282509

Japan

Japan (Hacchobori, 
Chuo-Ku, Tokyo)

8120 477392 (Toll 
free within Japan) or
81 3 5566 6230

8120 477120 (Toll free 
within Japan) or
81 3 5566 6507

Latin America

Caribbean countries, 
Mexico, and Central 
America

52 55 35 3610 52 55 66 2308

Brazil 0 800 704 9004 or 
55 11 5070 9654

55 11 5070 9694/95

Argentina 800 666 0096 55 11 5070 9694/95

Chile 1230 020 9102 55 11 5070 9694/95

Uruguay 0004 055 654 55 11 5070 9694/95

Region
Telephone
Dial...

Fax
Dial...

To submit technical questions from North America or Europe:

Step Action

1 Access the Applied Biosystems Technical Support Web site.

2 Under the Troubleshooting heading, click Support Request Forms, 
then select the relevant support region for the product area of 
interest.

3 In the Personal Assistance form, enter the requested information and 
your question, then click Ask Us RIGHT NOW.
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To Obtain
Documents on

Demand

Free, 24-hour access to Applied Biosystems technical documents, 
including MSDSs, is available by fax or e-mail or by download from our 
Web site.

4 In the Customer Information form, enter the requested information 
and your question, then click Ask Us RIGHT NOW.

Within 24 to 48 hours, you will receive an e-mail reply to your 
question from an Applied Biosystems technical expert.

To submit technical questions from North America or Europe:

Step Action

To order 
documents... Then...

by index 
number

a. Access the Applied Biosystems Technical Support Web 
site at 
http://www.appliedbiosystems.com/techsupp

b. Click the Index link for the document type you want, 
then find the document you want and record the index 
number.

c. Use the index number when requesting documents 
following the procedures below.

by phone for 
fax delivery

a. From the U.S. or Canada, call 1-800-487-6809, or
from outside the U.S. and Canada, call 1-858-712-0317.

b. Follow the voice instructions to order the documents 
you want.

Note There is a limit of five documents per request.
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To Obtain
Customer Training

Information

The Applied Biosystems Training web site at 
www.appliedbiosystems.com/techsupp/training.html
provides course descriptions, schedules, and other training-related 
information.

through the 
Internet for fax 
or e-mail 
delivery

a. Access the Applied Biosystems Technical Support Web 
site at 
http://www.appliedbiosystems.com/techsupp

b. Under Resource Libraries, click the type of document 
you want.

c. Enter or select the requested information in the 
displayed form, then click Search.

d. In the displayed search results, select a check box for 
the method of delivery for each document that matches 
your criteria, then click Deliver Selected Documents Now 
(or click the PDF icon for the document to download it 
immediately).

e. Fill in the information form (if you have not previously 
done so), then click Deliver Selected Documents Now to 
submit your order.

Note There is a limit of five documents per request for 
fax deliver but no limit on the number of documents you 
can order for e-mail delivery.

To order 
documents... Then...
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Glossary

calibrator A sample used as a basis for comparison with the other samples on the TaqMan Human 
Endogenous Control Plate.

endogenous control RNA or DNA that is present in each experimental sample as isolated. By using an 
endogenous control as an active reference, you can normalize quantification of a messenger RNA 
(mRNA) target for differences in the amount of total RNA added to each reaction.

exogenous control Characterized RNA or DNA spiked into each sample at a known concentration. An 
exogenous active reference is usually an in vitro construct that can be used as an internal positive 
control (IPC) to distinguish true target negatives from PCR inhibition. An exogenous reference can 
also be used to normalize for differences in efficiency of sample extraction or complementary DNA 
(cDNA) synthesis by reverse transcriptase.

reference A passive or active signal used to normalize experimental results. Endogenous and 
exogenous controls are examples of active references. Active reference means the signal is 
generated as the result of PCR amplification. The active reference has its own set of primers and 
probe.

Rn
+ The Rn value of a reaction containing all components including the template.

Rn
– The Rn value of an unreacted sample. This value can be obtained from the early cycles of a Real 

Time run (the cycles prior to a detectable increase in fluorescence) or from a reaction not containing 
template.

∆Rn The difference between the Rn
+ value and the Rn

– value. It reliably indicates the magnitude of the 
signal generated by the given set of PCR conditions. 

threshold cycle (CT) The value is the cycle at which a statistically significant increase in ∆Rn is first 
detected. Calculated as the average standard deviation of Rn for the early cycles, multiplied by an 
adjustable factor.
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